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Planning 
Virtual Experiments (VEs) vary hugely in complexity and development time. Making an 

effective VE requires a lot of thought and good planning. This document is designed to help 

guide you through key concepts to get the best out of your VE. 

LEARNING OUTCOMES 
Taking a more pedagogical view, first define an ultimate learning goal, whether it be to 

familiarise the student with the equipment, to explore phenomena or to understand the 

consequences of measurement. Then examine which learning path the students will need to 

follow. This will provide a baseline and context throughout the VE development. 

LAYOUT 
This is important for both aesthetics and usability; both help the student engage with the VE. 

The aim is to simplify the process and make performing the experiment as obvious as 

possible without removing too much realism. 

 

From a technical prospective we focus on framing the shot, what equipment will be used, 

where will it be positioned and how it will be used. 

 

Students may feel irritated or confused by not knowing how something works or what it does. 

Good design can significantly reduce this anxiety, so we strive to make VEs as intuitive as 

possible. 

RANGE OF VARIABLES 
The range of variables ultimately defines how long the project will take to complete and its 

complexity. The best approach is to work backwards from the final equations and graphs you 

wish the students to find, and determine which variables over what ranges will be needed. It 

is usually good practice to use a step size far smaller and range larger than the student 

would realistically use, to ensure they are given a choice and have to make educated 

decisions. 

PRIORITISING 
The process of making a VE involves several independent tasks, which can normally be run 

in parallel to increase efficiency. Prioritising key tasks such as designing the layout or 

making the framework in Flash before capture stage can also save you time. 
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COMPLIANCE TESTING 
Bug hunting and tracking is a key part of the development process; bugs can affect the user 

experience to the point that the VE becomes unusable. Quality tolerances should be agreed 

and bugs should be tracked in priority order of time to fix against benefits. 

 

User testing is the best way of finding bugs and monitoring the usability of the VE. It can be 

time consuming, and its effectiveness is largely dependent on the abilities of the person 

leading the testing. That said, the insights available from good user testing can be 

remarkable. 

INTERACTION 
Decide on the level of interaction and virtualisation you want in your VE. Some VEs require 

the student to setup or calibrate the equipment, others require students to simply switch on 

apparatus and some only require a measurement.  

 

Measuring devices need to be selected carefully. Digital displays can be easier to work with 

but do not provide visual feedback like analogue displays; other equipment such as rulers 

and stopwatches will all have to be modelled. Some of these can be usability disasters, as 

replacing two hands with a single mouse is always tricky. 

 

The uses of learning devices such as contextual specific messages or checklists provide 

benefits, but are prone to “getting in the way” and spoiling the experience. 

STORYBOARD 
Storyboards are important frameworks which normally provide a starting point for 

development. Their main role is to describe the user journey and their interaction with the 

VE. A storyboard focuses more on the VE’s user interface elements (next buttons, changing 

views, etc.) rather than the experimental interactive elements (knobs and dials). The 

storyboard is different for every experiment, but normally features common elements 

depending on your institutions chosen branding and paradigms; eg title screen, selection 

screen and then experiment screen 

 

Storyboards should result in clean and simple user interfaces with as few frames as possible 

whilst remaining intuitive. 
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Capture 
The look and feel of a Virtual Experiment (VE) is crucial for a quality user experience. An 

experiment captured well not only looks professional and credible but will also help to 

immerse the user, which is the greatest benefit VEs have over simulations. 

SETTING THE SCENE 
The stage and background can help to give the VE a different look and feel. A plain solid 

colour background helps the user not to get distracted, and gives the impression of a tightly 

controlled environment. A more natural environment, for example in a lab with other 

equipment out, helps acclimatise the user, but can cause aesthetic issues (messy cables, 

unwanted reflections, and images that later require editing). 

CAPTURE EQUIPMENT 
A decent SLR camera should be appropriate for most experiments. It has the ability to take 

very high resolution photos and can capture 30 minutes of film. Choosing the correct lens 

can sometimes be a challenge. The lens size is given in mm and written on the lens, the 

larger the lens size the greater the zoom capacity. 

 

Prime lens (e.g. 20mm) are fixed focal length lens, they have no variable zoom. They give 

the best image quality but not having a zoom makes them less versatile. 

 

Zoom lens (e.g. 17-70mm) offer the best versatility but suffer from a phenomenon known as 

lens barrelling, in which the image is distorted at the edges when either fully zoomed out or 

fully zoomed in. This effect can be corrected but its best to avoid it by not using the 

maximum and minimum focal distance of the lens. 

FRAMING THE EQUIPMENT 
Hopefully by this stage you already have a storyboard to direct what equipment needs to be 

in which shots. There are several things to consider when positioning the equipment: 

 It is important to fill the shot with the equipment; any unfilled space will be cropped in 

the editing stage and the pixels thrown away 

 Legibility; all the equipment needs to be in shot and readable when fully zoomed out 

(unless another mechanism like a magnifying glass is going to be used) 

 Layout must be clear. The users cannot look around the back to see where the 

equipment is plugged in - aim to show every cable neatly and clearly. 
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CAMERA SETUP 
VEs work by switching images, therefore any changes in the images will be clearly noticed. 

The aim is to remove as many unwanted changes as possible while controlling the 

conditions. 

 

The first step in setting up the camera is to set the white balance. This calibrates the 

camera’s sensor so what we see as being white it too sees as white. White balancing varies 

between makes and models but is normally found in the settings section labelled WB. It 

usually requires a source photo which you can take by placing a white piece of paper in front 

of the equipment and taking a photo. Once the camera’s white balance has been set, you 

should see the colours replicated accurately on the LCD. 

 

The next step is to set the camera’s exposure. Putting the camera into full manual mode (‘M’ 

mode) allows control of the aperture, shutter speed and ISO setting without the camera 

trying to guess the correct setting. All 3 settings affect the exposure of the camera. Since 

conditions are never the same between experiments, there is no single solution which fits all. 

Every experiment will require adjustment of these 3 settings so a basic understanding of 

what they all do is necessary. 

 

Aperture 

defines how large the lens opens when taking the photo. A large aperture (low f-stop) means 

more light can enter the camera which is useful in low light conditions. A large aperture also 

gives a large depth of field and very tight focus, meaning the camera cannot keep everything 

in shot in focus. 

 

Shutter Speed 

given in 1/x seconds (e.g. a shutter speed of 40 = 1/40th of a sec). This is how long the 

shutter stays open for. A long shutter speed allows more light to enter the camera but makes 

it more prone to blurring the shot because the camera can shake.  

 

ISO setting 

given as a multiple of 100, this defines how sensitive the film is. Higher ISO settings amplify 

the sensor’s sensitivity, increasing exposure, but any ISO over 500 can add noticeable 

graining and artifacting (seen as “noise”) as the sensor overcompensates for the lack of light. 
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General good practice procedure for setting up the camera: 

1. Focus the camera either manually using the lens disk or automatically by moving the 

focusing ring 

2. Set the camera to manual focus so it does not try to refocus between shots 

3. Switch the camera to manual mode 

4. Set the ISO to an acceptable level; ISO 400 on a normal day, or ISO 800 if it’s a dark 

experiment 

5. Set the aperture to as large as possible checking to make sure all the equipment 

stays in focus  

6. Set the shutter speed to a fast setting such as 100, and decrease the shutter speed 

(stays open longer) until the light meter indicates the correct exposure. Take some 

sample shots and view on computer screen 

7. If shutter speed goes above 20 then increase the ISO and continue adjusting the 

shutter speed. 

CONTROL LIGHTING 
Lighting has a big effect on the aesthetics and professionalism of the final VE. Suitable 

lighting is very easy to set up; the main aims are to reduce hard shadows and reflections. 

 

By placing lights either side of the subject, most of the hard shadows should disappear. 

Pointing a third light up to the ceiling can help ‘flood’ the stage with light, further reducing 

shadows. 

 

Reducing reflections can be more difficult. Depending on the experiment, a black screen 

behind the camera can help or slightly rotating the object or moving a light to ensure it 

doesn’t reflect into the camera. Sometimes reflections are unavoidable; for example, if 

working in a well-lit lab with a lot of glassware. It is good practice to check all glossy/glass 

items in shot via a computer screen for unwanted and avoidable reflections. 

EXPERIMENT CAPTURE 
A key point to note when photographing the experiment are to be careful not to move the 

camera and to make sure the photographer or his reflection is not in the shot. Both can be 

avoided by using a remote switch or extension so the photographer does not need to 

physically touch the camera between shots. 

 

It is usually beneficial to plug the camera into a laptop or computer and run the Canon 

remote control software. This gives you a live feed of what the camera is seeing and allows 

the photographer to change all the camera settings, change the focus and even take the 

photos without the need of a remote switch or extension. The program can also be set up to 

save the photos to the computer’s hard disk or a network share, cutting out a step of 

processing.  
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Development 
The Development stage of a Virtual Experiment (VE) is the longest and most varied. Every 

VE is different and there is no process which works for them all. Here is some good practice 

and things to consider. 

VIDEO ENCODING 
This process is complex and very important to get right. If it’s done badly it can result in poor 

quality videos and/or very large files; both detract from the experience and the appeal of the 

VE, either visually or by degrading its performance. 

 

There are several different techniques and procedures to produce the videos ready for 

embedding in Flash. They all give the same final output so it’s best to use what you’re 

comfortable with. 

 

The HE STEM team has written a guide using Adobe After Effects, which is part of the 

Adobe CS package. The guide can be found in the last chapter of this manual. 

ACTIONSCRIPT METHODOLOGY 
ActionScript 3 (AS3) is an interrupt driven scripting language based on JavaScript. It has a 

very simple and clear syntax. Programming listeners for Mouse, Timer and Movie events are 

examples of events used to control the code. 

OBJECT ORIENTED PROGRAMMING 
Everything in Flash is organised into separate objects. Objects can have properties (colour, 

size etc.) which can be read or changed, and methods (play, stop) which invoke the object to 

‘do’ something. Objects can be nested to create new objects too. Each object has a ‘type’ 

which defines its properties and methods (MovieClip, Buttons and graphics). 

USING MOVIECLIPS 
Movieclips are the most versatile objects; most user interface objects are of the movieclip 

type. They can be moved around, have their opacity changed and even dynamically add and 

remove objects from inside the movieclip. Movieclips are accessed by their ‘name’; anything 

inside a MovieClip is accessed with the parent name, followed by a dot then the inner object, 

eg parent.object 

IMPORTING MEDIA 
Flash can handle most media given to it (movies, pictures, vectors) without any problems. To 

import a movie correctly, it must be embedded into the timeline as opposed to hotlinked, 

allowing full control of the movie via Actionscript. Importing into a MovieClip also makes the 

video a standalone object, which is a far easier to control than placing on the timeline. 
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SWITCHING VIDEOS 
Once all the videos are imported, changing which video to show can be problematic. The 

recommended method is to make a place holder MovieClip and dynamically add the 

MovieClip containing the correct video as a child using ActionScript. This can cause 

problems in referencing the added MovieClip, as they will all need unique names. 

PRELOADER 
Some experiments contain more media than others. For larger VEs a preloader is essential. 

Flash by default will display an empty blank stage until the SWF is fully loaded. This blank 

state gives no feedback to the user to wait and they will always assume it’s ‘broken’. Adding 

a preloader removes this problem by showing a loading progress bar, and gives you the 

opportunity to display some branding. The preloader code can be fairly complicated but 

examples will be given. 

 

As a rule of thumb it’s best to make sure each VE is less than 30mb; this keeps the VE 

accessible, ensuring it can be downloaded in an acceptable time. The total size of the VE is 

normally defined by the size and thus quality of the videos. 

LIBRARIES AND CLASSES 
As everything is made up of objects in Flash, these objects can be packaged up into external 

classes. These classes are separate files and allow the code to be reused in different VEs. 

The classes are completely independent and modular; this has huge benefits as there are 

usually common components in a lot of VEs. Writing them out into classes means there is no 

need to re-write the code, saving time. As they are separate independent files, all VEs using 

the class can benefit from any improvement or development. 

 

The VE team has a range of useful classes it has been developing. Some examples include: 

 An extensive dial (knob) class 

 Rulers and protractors 

 Simple skin and styled buttons 

 Stopwatches 

 Tooltip system 

 Messaging system 

 Counter 

 Dialogue system 

 

Any object can be made into a separate class. Once a code base of classes has been 

written and tested, the VE’s development time drops significantly as each subsequent one 

will require fewer lines of code. 

PUBLISHING 
Publishing the project involves making the SWF and HTML files. This should not be 

confused with deployment which involves uploading the compiled SWF and HTML files to 

the web or a VLE. Flash does most of the work when publishing, but it is important to make 

sure the HTML file has ‘with fullscreen support’, otherwise the else that feature will not work. 
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Encoding Procedure 
This is the encoding procedure the HE STEM team use to make the RAW files suitable for 

Flash. The technique has been developed to be as efficient as possible in terms of time 

taken to edit, getting the best image quality and smallest file size. 

VIDEO OR PICTURES 
Processing pictures into a movie requires a few extra steps. The procedure will focus on 

using pictures; if your RAW media is already a video, then most of the steps still apply. 

PROCEDURE 
1. Load up Adobe After Effects 

 

First, make sure the import settings are correct before we import 

2. Edit -> Preferences ->Import 

3. Change Sequence Footage option to 30 frames per second 

 This is important as the movie will need to match the frame rate of Flash   

 

Next, Import the files 

4. File -> Import 

 Make sure to select all the files (click first one, hold shift key and then select last 

one) 

5. If you are importing a collection of pictures make sure ‘JPEG Sequence’ check box 

is ticked 

6. Click Open 

7. Drag the newly made item in the ‘Project’ tab on the left into the middle of the screen 

which is the composition tab; this will make a new composition. 

8. Right click the newly made composition -> ‘Composition Settings’ 

9. Change the width and height of the composition to match your required final output 

 We recommend encoding the video at twice the dimensions you wish to use in 

Flash. This ensures the video still looks good when in fullscreen mode 

 

Next adjust the image 

10. Open up the properties of the object inside the composition by clicking the small 

grey arrow: 

 

11. Rotate the image if required (use view -> Show Grid to help) 
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12. Position the image with the Position X and Y values 

13. Change the scale to fill the composition with the subject and ensure there are no 

black areas 

14. Drag the ‘levels’ effect on to the composition in the middle of the screen 

 

15. Adjust the sliders in the effects tab for each colour channel so the sliders fill the 

entire histogram. This should help white-balance the image: 

 

16. Use the middle slider to change the gamma of the channel, allowing you to fine tune 

the colours 

17. Apply other effects such as ‘Hue and saturation’, ‘Highlight and Shadow’ and 

‘Brightness and Contrast’ to help bring out colours and subjects. 
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Now we must Set up the encoder 

18. With the composition selected, click ‘Composition’ -> ‘Add to Render Queue’ 

19. Click the ‘Output Module’ name to modify the profile 

20. Change ‘Format’ to ‘FLV’ 

 this is the only format with which we can embed the video into Flash 

21. Tick the ‘Audio Output’ box if audio is needed 

22. Click “Format Options...” 

23. Set the bitrate from 200 kbps to 5,000 kbps depending on the purpose: 

 if you only have fewer than 10 images in the video then use 5,000 kpbs  

 Larger sets of images need to be encoded at 200 kbps to keep file size down 

 The bitrate defines the quality of the final product; the lower the bitrate, the worse 

the image quality. Some experimenting will be required, as the visual quality 

depends on the subject of the video. 

24. Set the undershoot to 100% if using images which the user will pause on; if not, then 

set to 90% 

25. Click the ‘Output To:’ name, set the file name and saved file destination 

26. Click Render. 

27. The render time varies from a few seconds to hours depending on number of frames 

and bitrate. 

28. Once the render is complete the video will be ready for Flash. 
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